
 

 

BAB V 

ANALISIS DAN PEMBAHASAN 

 

5.1 Penyajian Data 

Data-data yang dimasukkan (input) dalam program ini adalah data-data 

numerik dalam format tabel dengan n-data yang berupa tabel data hujan (P), tabel 

data evapotranspirasi (ETo), dan tabel data debit terukur di lapangan (Qobs.) 

Kemudian hasil keluaran (output) dari program akan disajikan dalam format tabel 

perhitungan dan grafik data. Tabel perhitungan menyajikan data perhitungan 

lanjutan dari data yang dimasukkan (input). Sedangkan grafik data yang disajikan 

berupa grafik data hujan, grafik data debit terhitung, grafik data debit terukur 

dengan nilai-nilai yang sudah memenuhi syarat evaluasi model yang telah 

ditentukan. 

5.1.1 Data Sekunder 

Data sekunder dalam penelitian ini berupa semua data parameter dan tahapan 

analisis dalam metode RAINRUN yang dimasukkan dalam algoritma pemograman 

untuk menghitung dan menganalisis data-data masukan (input) sehingga diperoleh 

hasil keluaran (output). 

5.1.2 Data Primer 

Proses pembuatan program ini tidak menggunakan data primer dalam 

algoritma pemogramannya, hanya saja dalam hal penggunaan, data masukan 

(input) dalam pemograman ini adalah data yang diambil dari hasil pengamatan di 

lapangan (observasi). Namun, untuk mempermudah penggunaan dalam hal lain 

(sebagai sarana pembelajaran), juga dapat digunakan data yang 

dimodifikasi/dimanipulasi sesuai dengan tujuan pembelajaran. Validitas data 

masukan (input) tergantung dari pengambilan data di lapangan (observasi). Data 

masukan (input) harus dimasukkan ke dalam Microsoft Excel terlebih dahulu 

dengan format yang sudah ditentukan dalam ketentuan penggunaan program. 
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Data-data masukan (input) adalah berupa data hujan (P) dalam satuan mm, data 

evapotranspirasi (ETo) dalam satuan mm, dan data debit observasi (Qobs.) dalam 

satuan m³/detik. Jika satuan data masukan (input) masih dalam satuan yang 

berbeda, maka user program disarankan untuk mengkonversi terlebih dahulu 

satuan tersebut ke dalam satuan yang telah ditentukan. 

5.2 Hasil Pemograman 

5.2.1 Pemograman Komputer 

Visual Basic adalah salah satu kompiler yang menggunakan bahasa 

pemrograman Basic. Bahasa pemrograman adalah perintah-perintah yang 

dimengerti oleh komputer untuk melakukan tugas-tugas tertentu. Kompiler 

pemrograman Visual Basic, yang dikembangkan oleh Microsoft sejak tahun 1991, 

merupakan pengembangan dari pendahulunya yaitu bahasa pemrograman BASIC 

(Beginner’s All-purpose Symbolic Instruction Code) yang dikembangkan pada era 

1950-an. Visual Basic merupakan salah satu development tool, yaitu alat bantu 

untuk membuat berbagai macam program komputer, khususnya yang 

menggunakan sistem operasi Windows (Suryokusumo, 2000). 

5.2.2 Struktur Program 

Program dalam penelitian ini disusun dalam struktur pemograman dengan 

menggunakan 14 form dan 4 module, yaitu sebagai berikut: 

Susunan Form : 

- Form1 (Form Login)  

- Form2 (Form Menu Utama) 

- Form3 (Form Input Data Hujan Manual) 

- Form4 (Form Input Data ETo Manual) 

- Form5 (Form Input Data Debit Terukur Manual) 

- Form6 (Form Grafik Data Hujan) 

- Form7 (Form Grafik Data ETo) 

- Form8 (Form Grafik Data Debit Terukur) 

- Form9 (Form Perhitungan Awal) 

- Form10 (Form Optimasi Model RAINRUN) 
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- Form11 (Form Kalibrasi Model RAINRUN) 

- Form12 (Form Verifikasi Model RAINRUN) 

- Form13 (Form Simulasi Model RAINRUN) 

- Form14 (Form Grafik Data Perhitungan Optimasi Model) 

Susunan Module : 

- Module1 (Module Import Excel Data Hujan) 

- Module2 (Module Import Excel Data ETo) 

- Module3 (Module Import Excel Data Debit Terukur) 

- Module4 (Module Eksport File Perhitungan Program ke Excel) 

Adapun tampilan antar muka (user interface) masing-masing form dapat 

dilihat pada gambar-gambar berikut ini. 

1. Form User Login 

Tampilan form user login dapat dilihat pada gambar 5.1 di bawah ini. Form ini 

hanya berisi untuk data pengguna (user) saja. 

 
Sumber : Hasil Penelitian 

Gambar 5.1 User Interface Form1 (Form Login) 
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2. Form Menu Utama 

Tampilan form Menu Utama dapat dilihat pada gambar 5.2 di bawah ini. Form ini 

berisi input data DAS dan input data untuk data hujan, data evapotranspirasi dan 

data debit observasi. 

 
Sumber : Hasil Penelitian 

Gambar 5.2 User Interface Form2 (Form Menu Utama) 

3. Form Input Data Hujan (Manual) 

Tampilan form Input Data Hujan dapat dilihat pada gambar 5.3 berikut ini. Form 

ini berisi tabel kosong untuk memasukkan data hujan secara manual. 

 
Sumber : Hasil Penelitian 

Gambar 5.3 User Interface Form3 (Form Input Data Hujan Manual) 
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4. Form Input Data Penguapan (Manual) 

Tampilan form Input Data Penguapan dapat dilihat pada gambar 5.4 berikut ini. 

Fungsinya sama dengan form sebelumnya. 

 
Sumber : Hasil Penelitian 

Gambar 5.4 User Interface Form4 (Form Input Data Penguapan Manual) 

5. Form Input Data Penguapan (Manual) 

Tampilan form Input Data Penguapan dapat dilihat pada gambar 5.5 berikut ini. 

Fungsinya sama dengan form sebelumnya. 

 
Sumber : Hasil Penelitian 

Gambar 5.5 User Interface Form5 (Form Input Data Debit Observasi Manual) 
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6. Form Grafik Data Hujan 

Tampilan Form Grafik Data Hujan dapat dilihat pada gambar 5.6 berikut ini. 

Form ini menampilkan grafik dari data hujan yang dimasukkan di input data. 

 
Sumber : Hasil Penelitian 

Gambar 5.6 User Interface Form6 (Form Grafik Data Hujan) 

7. Form Grafik Data Penguapan 

Tampilan Form Grafik Data Penguapan dapat dilihat pada gambar 5.7 berikut ini. 

Form ini menampilkan grafik dari data penguapan yang dimasukkan di input data. 

 
Sumber : Hasil Penelitian 

Gambar 5.7 User Interface Form7 (Form Grafik Data ETo) 
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8. Form Grafik Data Debit Observasi 

Tampilan Form Grafik Data Debit dapat dilihat pada gambar 5.8 berikut ini. Form 

ini menampilkan grafik dari data debit observasi yang dimasukkan di input data. 

 
Sumber : Hasil Penelitian 

Gambar 5.8 User Interface Form8 (Form Grafik Data Debit Terukur) 

9. Form Grafik Data Perhitungan Awal 

Tampilan Form Grafik Data Perhitungan Awal dapat dilihat pada gambar 5.9 

berikut ini. Form ini menampilkan hasil perhitungan analisis RAINRUN sesuai 

dengan rumus-rumus dalam analisis RAINRUN. 

 
Sumber : Hasil Penelitian 

Gambar 5.9 User Interface Form9 (Form Perhitungan Awal) 
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10. Form Optimasi Model RAINRUN 

Tampilan Form Optimasi Model RAINRUN dapat dilihat pada gambar 5.10 

berikut ini. Form ini menampilkan pilihan optimasi (kalibrasi, verifikasi dan 

simulasi) sesuai dengan peruntukannya optimasinya. 

 
Sumber : Hasil Penelitian 

Gambar 5.10 User Interface Form10 (Form Optimasi Model RAINRUN) 

11. Form Kalibrasi Model RAINRUN 

Tampilan Form Optimasi Model RAINRUN dapat dilihat pada gambar 5.11 

berikut ini. Pada form ini, semua parameter akan dioptimasi dengan menggunakan 

kombinasi solver excel dengan solving method evolutionary pada solver-nya. 

Tampilan solver-nya memang sama dengan tampilan solver pada Microsoft Excel, 

hanya saja pada aplikasi ini, solving dapat dilakukan hanya dengan menekan 

tombol “SOLVING” yang ada di dalamnya. 

 
Sumber : Hasil Penelitian 

Gambar 5.11 User Interface Form11 (Form Kalibrasi Model RAINRUN) 



 

57 
 

12. Form Verifikasi Model RAINRUN 

Tampilan Form Verifikasi Model RAINRUN dapat dilihat pada gambar 5.12 

berikut ini. Pada form ini, nilai parameter hasil optimasi dimasukkan ke 

perhitungan kembali menggunakan data lanjutan dari data yang dikalibrasi.  

 
Sumber : Hasil Penelitian 

Gambar 5.12 User Interface Form13 (Form Verifikasi Model RAINRUN) 

13. Form Simulasi Model RAINRUN 

Tampilan Form Simulasi Model RAINRUN dapat dilihat pada gambar 5.12 

berikut ini. Pada form ini, nilai parameter hasil optimasi dimasukkan ke dalam 

perhitungan kembali menggunakan semua data hujan yang diinput di awal. 

 
Sumber : Hasil Penelitian 

Gambar 5.13 User Interface Form14 (Form Simulasi Model RAINRUN) 
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14. Form Grafik Hujan-Debit Hasil Analisis RAINRUN 

Tampilan Form Grafik Data Debit dapat dilihat pada gambar 5.8 berikut ini. Form 

ini menampilkan grafik data debit dan hujan yang diperoleh dari hasil akhir 

analisis RAINRUN yang telah dilakukan. 

 
Sumber : Hasil Penelitian 

Gambar 5.14 User Interface Form14 (Form Grafik Huajn-Debit Hasil Analisis 

RAINRUN) 

5.2.3 Algoritma Pemograman 

Algoritma Pemograman atau kode program (pseudo code) dalam program ini 

selengkapnya dapat dilihat pada lampiran. 

5.3 Tahapan Penggunaan Program 

Tahapan pengoperasian program ini dapat dilakukan dengan mengikuti 

prosedur berikut ini. 

1. Semua input data numerik (angka) dalam keseluruhan program ini 

menggunakan standar internasional, yaitu menggunakan tanda titik untuk 

menunjukkan nilai desimal. 

2. Pengisisan form Login dapat dilakukan dengan memilih/mengklik pilihan tipe 

user dalam combo box yang telah disediakan dalam program ini, yang terdiri 



 

59 
 

dari “Mahasiswa” dan “Dosen”. Untuk pilihan tipe user “Mahasiswa” akan 

muncul 2 textbox kosong, yaitu textbox untuk pengisian Nama User dan NIM 

yang dapat diisi dengan tipe data string (huruf) ataupun angka (jika identitas 

user tidak ingin diketahui). Sedangkan untuk pilihan tipe user “Dosen” akan 

muncul 1 textbox kosong yang dapat diisi dengan tipe data string (huruf) 

ataupun angka (jika identitas user tidak ingin diketahui) untuk pengisian 

Nama User saja. Selanjutnya tinggal mengklik tombol MASUK jika ingin 

melanjutkan penggunaan program, atau KELUAR jika ingin mengakhiri 

penggunaan program. 

3. Setelah melakukan pengisian data pada form Login, selanjutnya akan muncul 

tampilan Menu Utama dari program ini yang merupakan form untuk 

pengisian data input hujan (P), data evapotranspirasi (ETo) dan data debit 

terukur (Qobs.). Untuk pengisian input data hujan (P), data evapotranspirasi 

(ETo) dan data debit terukur (Qobs) dapat dilakukan dengan dua pilihan. 

Pilihan pertama dapat dilakukan dengan menggunakan menu Browse File 

yang terdapat dalam menu File → Input Data → Browse File dalam 

program. File yang dapat dibaca oleh ”browse file” adalah file Excel 97-2003 

Worksheet berekstensi (*.xls). Untuk file excel 2007 atau yang terbaru 

berekstensi (*.xlsx) maka diharuskan untuk mengkonversi file terlebih dulu 

ke ekstensi (*.xls) dengan cara meng-Save As file dari Ms. Excel 2007 atau 

yang terbaru, kemudian rubah ekstensi file pada pilihan file type menjadi 

Excel 97-2003 Worksheet (*.xls). Pilihan kedua dapat dilakukan dengan 

menggunakan “input data manual” yang dapat diakses dalam menu File → 

Input Data → Input Data Manual pada program. User dapat mengisikan data 

hujan, data evapotranspirasi dan data debit terukur pada form input data 

manual yang telah disediakan apabila user tidak ingin menginput data dari 

Microsoft Excel. 

4. Pada form Menu Utama terdapat tombol Tampilkan Data Hujan, Tampilkan 

Data Penguapan, dan Tampilkan Data Debit Terukur. Ketiga tombol ini 

memiliki fungsi yang sama, yaitu untuk membuka tampilan baru yang 

menyajikan grafik data dari input data (hujan, penguapan, dan debit terukur) 
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yang telah dimasukkan. Untuk mengembalikan tampilan ke Menu Utama 

dapat dilakukan dengan mengklik tombol OK atau tombol close (x) pada 

form Grafik Data (hujan, penguapan atau debit terukur). 

5. Selanjutnya, setelah semua data telah di-input, dengan mengklik tombol OK 

maka akan muncul tampilan form perhitungan awal. Untuk melakukan 

perhitungan dapat dilakukan dengan cara mengklik tombol Hitung yang 

tersedia pada form perhitungan awal, tunggu beberapa saat sampai 

perhitungan selesai dilakukan. Pada form ini, parameter RAINRUN awal 

perhitungan diambil berdasarkan buku terjemahan Kondisi Hidrologi Di 

Indonesia karya Rob van der Wert (1994) dan difokuskan pada nilai-nilai 

maksimum berdasarkan buku tersebut. Nilai-nilai tersebut dapat diubah 

sesuai dengan keinginan user (selanjutnya akan dijelaskan pada form 

berikutnya). 

6. Sebagaimana dengan beberapa pemodelan hidrologi lainnya, hal yang paling 

penting diperhatikan adalah tentang evaluasi ketelitian model. Program ini 

dibuat untuk mencari nilai-nilai parameter RAINRUN yang mendekati angka-

angka standard yang mengacu pada evaluasi ketelitian model, yaitu nilai 

korelasi (R) dan volume error (VE). Dalam program ini, nilai evaluasi 

ketelitian model dapat dilihat pada form Perhitungan Awal dimana akan 

ditampilkan hasil perhitungan evaluasi ketelitian model di samping parameter 

model. Perhitungan akan dilanjutkan pada optimasi model dengan cara 

mengklik tombol Run Optimasi Model sehingga akan muncul tampilan form 

baru yang menampilkan form Optimasi Model RAINRUN. Namun, jika ada 

kesalahan dalam menginput data hujan, data penguapan atau data debit 

observasi, user dapat mengklik tombol Kembali di bawah tombol Run 

Optimasi Model sehingga perhitungan pada form Perhitungan Awal akan di-

reset kembali menjadi perhitungan kosong dan dapat digunakan lagi untuk 

menghitung kembali data-data baru yang di-input. 

7. Setelah mengklik tombol Run Optimasi Model, program akan menampilkan 

form Optimasi Model RAINRUN yang terdiri dari beberapa frame yang 

berisi: 
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- Frame1 : data sungai yang diinput 

- Frame2 : data user program, variasi jam dan tanggal 

- Frame3 : parameter RAINRUN default dari form sebelumnya 

- Frame4 : parameter RAINRUN optimasi yang di-input sendiri 

- Frame5 : evaluasi ketelitian model 

- Frame6 : tabel perhitungan RAINRUN 

Pada form ini, user akan memilih untuk melakukan kalibrasi, verifikasi 

dan simulasi pada model yang akan dianalisis dengan cara mengklik combo 

box yang tersedia. Combo box akan menampilkan 3 pilihan optimasi 

(kalibrasi, verifikasi dan simulasi) dan user dapat memilih sesuai dengan 

kebutuhan. Kemudian, untuk menampilkan perhitungan sebelumnya, user 

dapat mengklik tombol Load Perhitungan Sebelumnya di bawah combo box 

yang tadi. Sebelum melakukan optimasi, user diharuskan untuk mengisi 

telebih dahulu parameter yang ada di frame4 (cukup mengisi nilai minimum 

dan maksimum saja, dan tidak boleh diisi dengan angka nol ataupun 

dikosongkan). 

Pengisian nilai minimum dan maksimum adalah bertujuan untuk 

membantu program untuk membatasi rentang nilai sehingga dapat men-

solving nilai-nilai parameter agar diperoleh nilai parameter yang optimal dan 

mendekati kondisi yang sebenarnya. Selanjutnya, hanya tinggal mengklik 

tombol Run Optimasi sehingga program akan memproses nilai parameter 

yang dimasukkan tadi dan menampilkan nilai-nilai parameter yang sudah di-

solve dari perhitungan evaluasi ketelitian model (pada frame5) ke dalam baris 

kotak Hasil Optimasi pada frame4. 

Apabila ingin mengambil hasil perhitungan optimasi pada baris kotak 

Hasil Optimasi (frame4), user cukup mengklik tombol Ambil Hasil Opt. pada 

form ini dan angka-angka pada baris kotak frame3 akan berganti menjadi 

angka-angka pada baris kotak frame4, dan baris kotak frame4 akan kembali 

kosong. User juga dapat mengisi kembali baris kotak yang kosong tersebut 

dengan perkiraan nilai-nilai parameter yang dirasa lebih baik dari nilai-nilai 

parameter sebelumnya. Sama seperti form sebelumnya, pada form ini juga 
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terdapat tombol Kembali yang memiliki fungsi yang sama dengan form-form 

sebelumnya, yaitu me-reset kembali perhitungan di form ini sehingga dapat 

digunakan kembali untuk perhitungan yang baru. Pada form ini terdapat form 

Keluar yang berfungsi untuk menutup program. Pada form ini juga, terdapat 

tombol Tampilkan Grafik Optimasi yang berfungsi agar menampilkan form 

baru untuk melihat grafik data hujan yang disandingkan dengan grafik data 

debit observasi dan debit hasil perhitungan RAINRUN. 

Apabila user ingin meng-export perhitungan ke dalam file excel (.xls), 

cukup dengan mengklik tombol Export to Excel dan program akan meng-

copy perhitungan ke dalam tampilan Microsoft Excel secara otomatis dan 

menampilkannya. 

5.4 Algoritma Sistem 

       Algoritma sistem dalam penelitian ini dibuat dengan menggunakan flowchart 

form yang berisi tahap-tahap penyelesaian masalah (prosedur) beserta aliran data 

agar lebih mudah dipahami. Algoritma sistem dalam penelitian ini terdiri dari 

beberapa flowchart form sebagai berikut: 

- Algoritma Sistem form Login (A) 

- Algoritma Sistem form Menu Utama (B) 

- Algoritma Sistem Input Data Manual (C) 

- Algoritma Sistem Grafik Data (D) 

- Algoritma Sistem Analisis RAINRUN (E) 

- Algoritma Sistem Optimasi Model (F) 

- Algoritma Sistem Kalibrasi Model (G) 

- Algoritma Sistem Verifikasi Model (H) 

- Algoritma Sistem Simulasi Model (I) 

- Algoritma Sistem Grafik Hujan-Debit (P-Q) Hasil Analisis RAINRUN (J) 

Beberapa dari algoritma sistem tersebut diantaranya ada yang saling 

berhubungan satu sama lain sehingga pada penggambaran flowchart-nya terdapat 

beberapa bagian yang terputus (terhenti), namun bukan berarti berakhir. Hal ini 

disimbolkan dengan gambar (⌂) terbalik disertai dengan huruf abjad di dalamnya 
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sesuai dengan simbol huruf pada masing-masing algoritma sistem yang ada. 

Fungsinya adalah agar siklus pemograman tetap saling berhubungan satu sama 

lain dan mencegah terjadinya debug (error running) pada saat menjalankan 

program. Sementara untuk melihat bahwa algoritma sistem berakhir disimbolkan 

dengan gambar (        )nyang disertain tulisan “End” di dalamnya. Semua 

algoritma sistem dalam pemograman ini dapat dilihat pada gambar-gambar 

berikut ini. 

1. Algoritma Sistem form Login (A) 

Pilih Tipe
User

Tipe User Mahasiswa
Input Data :

Tipe User Dosen

Input Data :

- Nama

- Nama

- No Mahasiswa

MASUK

KELUAR End

B

Y

N

A

 

Gambar 5.15 Flowchart form Login 

2. Algoritma Sistem form Menu Utama (B) 

B

Tampilan
Menu Utama

Input Data :

- Hujan (P)

- Penguapan (ETo)

- Debit Observasi (Qobs.)

Input ManualBrowse File

C

If Cancel

OK

E

Tampilkan

Grafik

D

End

Y

N

C

Tampilan

Input Manual

Input Data :

- Hujan (P)

- Penguapan (ETo)

- Debit Observasi (Qobs.)

Create n-data

If Cancel

OK

B

Y

N

no change

 

Gambar 5.16 Flowchart form Menu Utama 
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3. Algoritma Sistem Input Data Manual (C) 

B

Tampilan
Menu Utama

Input Data :

- Hujan (P)

- Penguapan (ETo)

- Debit Observasi (Qobs.)

Input ManualFile

C

Tampilkan

Grafik

C

Tampilan

Input Manual

Input Data :

- Hujan (P)

- Penguapan (ETo)

- Debit Observasi (Qobs.)

Create n-data

If Cancel

OK

B

Y

N

no change

D

Tampilan

Grafik Data

OK

B

 

Gambar 5.17 Flowchart Input Data Manual 

4. Algoritma Sistem Grafik Data (D) 

)

D

Tampilan

Grafik Data

OK

B

 

Gambar 5.18 Flowchart Grafik Data 
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5. Algoritma Sistem Analisis RAINRUN (E) 

E

Tampilan

Analisis RAINRUN

Hitung

Proses

Kembali

Reset E

B

N

Y

Run Optimasi

Model

F

Load

 

Gambar 5.19 Flowchart Analisis RAINRUN 

6. Algoritma Sistem Optimasi Model (F) 

E

Tampilan

Analisis RAINRUN

Hitung

Proses

Kembali

Reset E

B

N

Y

Run Optimasi

Model

F

F

Tampilan

Kalibrasi Model

Pilih Optimasi:

- Kalibrasi

- Verifikasi

- Simulasi

Verifikasi SimulasiKalibrasi

Load Perhitungan

Sebelumnya

Nilai Parameter

Optimasi (Manual)

Run Optimasi

G H I

Kembali Eksport to ExcelAmbil Hasil

Optimasi

Tampilkan Grafik

Optimasi
Keluar

End

Y

J

Y

Reset F

E

Microsoft

Excel

NN

J

Tampilan

Grafik Hujan-Debit (P-Q)

Hasil Analisis RAINRUN

Export to Excel
Kembali

Microsoft

Excel
F

Y

N

G

Tampilan

Run Kalibrasi

OK

F

N

Y

Solve

R = 0,7
VE = 5%

no change

 

Gambar 5.20 Flowchart Optimasi Model 
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7. Algoritma Sistem Kalibrasi Model (G) 

J

Tampilan

Grafik Hujan-Debit (P-Q)

Hasil Analisis RAINRUN

Kembali

Microsoft

Excel
F

Y

N

G

Tampilan

Kalibrasi Model

Run Kalibrasi
Kembali

Y

N

OK

F

N

Y

Solve

R = 0,7
VE = 5%

no change

H

Tampilan

Run Verifikasi

OK

F

N

Y

Solve

R = 0,7
VE = 5%

no change

 

Gambar 5.21 Flowchart Kalibrasi Model 

8. Algoritma Sistem Verifikasi Model (H) 

Kembali

Y

N

H

Tampilan

Verifikasi Model

Run Verifikasi
Kembali

Y

N

OK

F

N

Y

Solve

R = 0,7
VE = 5%

no change

Run 

OK

F

N

Y

Solve

R = 0,7
VE = 5%

 

Gambar 5.22 Flowchart Verifikasi Model 
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9. Algoritma Sistem Simulasi Model (I) 

H

Tampilan

Kembali

Y

N

no change

I

Tampilan

Simulasi Model

Run Simulasi
Kembali

Y

N

OK

F

N

Y

Solve

R = 0,7
VE = 5%

no change

 

Gambar 5.23 Flowchart Simluasi Model 

10. Algoritma Sistem Grafik Hujan-Debit (P-Q) Hasil Analisis RAINRUN (J) 

J

Tampilan

Grafik Hujan-Debit (P-Q)

Hasil Analisis RAINRUN

Export to Excel
Kembali

Microsoft

Excel
F

Y

N

G

Tampilan

Kalibrasi Model

Run Kalibrasi
Kembali

Y

N

OK

N

Y

Solve

R = 0,7
VE = 5%

no change

 

Gambar 5.24 Flowchart Grafik Hujan-Debit (P-Q) Hasil Analisis RAINRUN 
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5.5 Penerapan Program Pada Kasus 

Suatu pemodelan yang dibuat dengan menggunakan bahasa pemograman 

pada dasarnya haruslah memiliki suatu pengujian (validasi) untuk mengetahui 

apakah aplikasi yang dibuat akan dapat berjalan dengan baik atau tidak. Maka dari 

itu, pada penelitian ini juga diperlukan suatu contoh kasus untuk menguji apakah 

aplikasi yang telah dibuat dapat berjalan dengan semestinya. Untuk itu, contoh 

kasus yang akan diterapkan pada aplikasi buatan dalam penelitian ini akan diambil 

dari penelitian yang pernah dilakukan oleh Wiwin Nanti (2007), yaitu pada DAS 

Gajahwong dan DAS Winongo di Yogyakarta. Wiwin Nanti (2007) menganalisis 

unjuk kerja model RAINRUN dan NRECA pada kedua DAS tersebut dan 

membandingkannya. Namun, karena pengujian validitas aplikasi yang dibuat ini 

adalah untuk pertama kali, maka sebagai batasan dalam penelitian ini, penulis 

hanya menggunakan satu DAS saja, yaitu DAS Gajahwong yang berada di sta. 

Papringan yang dijadikan sebagai contoh kasus. Data-data yang terdapat pada 

DAS Gajahwong ini kemudian akan dianalisis dengan menggunakan aplikasi 

yang sudah dibuat. 

5.5.1 Data Masukan 

Data yang dibutuhkan dalam penerapan program sebagai data masukan 

pada model hujan-limpasan RAINRUN adalah data hujan, evapotranspirasi, debit 

terukur dan luas DAS. Sebagai validasi program diambil dari DAS Gajahwong di 

Papringan yang memiliki luas DAS sebesar 25.713 km
2 

untuk menguji validasi 

model yaitu model hidrologi dan juga metode optimasinya.
 

 Data curah hujan yang akan digunakan pada penerapan aplikasi ini sebagai 

data sekunder untuk validasi diambil dari stasiun klimatologi di Papringan dari 

tahun 1994 sampai dengan 2004 dengan alasan bahwa data tersebut memiliki 

panjang tahun data yang cukup panjang (lebih dari 5 tahun). Data curah hujan 

tersebut kemudian akan menjadi input data pada aplikasi yang akan diuji 

validitasnya. Data selanjutnya yang menjadi data masukan dalam aplikasi untuk 

validasi adalah data evapotranspirasi (ETo). Pada DAS Gajahwong data 

evapotranspirasi menggunakan data evapotranspirasi dari tahun 1994 sampai 
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dengan 2004 dengan jumlah data yang sama dengan data curah hujan. Data-data 

tersebut dapat dilihat pada Tabel 5.1 dan Tabel 5.2 di bawah ini. 

Tabel 5.1 Data Curah Hujan Rata-Rata Bulanan DAS Gajahwong di Papringan 

(mm) 

 

Tabel 5.2 Data Evapotranspirasi DAS Gajahwong di Papringan (mm) 

 

5.5.2 Hasil Analisa Aplikasi Visual Basic 

 Proses kalibrasi parameter dilakukan dengan menggunakan data pada 

tahun awal data (1994 – 1999), dan untuk data tahun berikutnya digunakan untuk 

uji verifikasi (1999 – 2004). Sedangkan uji verifikasi dilakukan untuk menguji 

apakah nilai parameter karakteristik hidrologi DAS yang ditinjau merupakan nilai 

yang cukup representatif untuk DAS tersebut. Uji verifikasi dilakukan dengan 

menghitung model RAINRUN dengan nilai parameter yang sudah didapat pada 

tahun data diluar tahun data yang digunakan untuk kalibrasi. Proses perhitungan 

dan analisis RAINRUN dengan Visual Basic dapat dilihat pada lampiran. 

 

1994 412.76 474.55 730.59 247.59 50.22 0 0 0 0 23.14 147.92 311.53

1995 484.94 506.93 368.86 187.27 96.62 211.32 44.68 0.12 1.55 149.01 644.42 282.39

1996 335.72 237.9 206.4 107.48 39.12 16.56 0.3 31.51 0.71 226.1 427.01 348.97

1997 333.34 366.5 49.21 144.62 42.82 4.27 0 0 0.18 2.52 55.95 253.33

1998 305.63 545.76 357.38 266.71 78.41 208.27 189.35 25.92 60.73 498.58 342.88 289.61

1999 402.49 328.17 368.28 322.15 158.49 35.97 47.43 1.07 6.84 160.54 313.94 342.26

2000 256.92 470.28 334.43 357.94 113.32 45.21 7.42 15.14 3.69 242.04 374.1 149.81

2001 397.02 299.81 522.5 270.98 132.31 129.49 24.83 0.99 9.22 441.76 293.82 218.2

2002 479.96 500.91 241.57 251.51 106.06 1.35 2.76 0 0 5.46 203.69 256.5

2003 294.63 396.28 391.45 84.21 134.8 20.91 0 0 3.72 33.2 168.38 252.66

2004 0 0 0 0 0 0 0 0 0 0 0 0

JunMayTahun Jan Feb Mar Apr DecNovOctSepAugJul

1994 157.1 129.5 120.5

1995 109.5 112.1 114.5 116 114.9 91.9 115 151.6 160.1 140.3 94 138.7

1996 122.5 136.4 129.2 124.8 128 121.7 141 140.8 165.6 123.9 106.6 138.2

1997 145 125.1 162 123.1 119.4 118.8 133.5 142 174.3 172.5 147.7 123.4

1998 126.2 90.3 108.8 106.2 113 88.6 98.3 133.6 130.7 100.5 115.2 142.6

1999 127.2 133.4 128.1 113.9 105.2 102 109.7 149.6 150.7 128.8 112.5 118

2000 133.8 105.8 134.1 107.9 110 105.8 127.4 129.7 151.5 121.3 105.2 149.4

2001 124.5 154.7 104.7 89.1 103.5 91.8 115.8 134.9 142.7 99.8 110.7 130.3

2002 106.4 100.8 119.4 107.5 107.7 104.4 114.3 143 166.6 170.2 126.3 127.7

2003 121.3 94.3 100 120.6 105.9 109.6 136.3 145 146.7 148.1 121.6 117.6

2004 107.4 114.8 112.5 126.3 104 104.2 104.1 124.2 153.4 83.4 70.5 68.2

Tahun JunMayAprMarFebJan DecNovOctSepAugJul
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1. Hasil kalibrasi parameter model RAINRUN 

Pada penggunaan aplikasi Visual Basic yang dibuat dalam penelitian ini 

untuk sta. Papringan, parameter karakteristik DAS Gajahwong hasil kalibrasi 

seperti yang terlihat pada Tabel 5.3 berikut ini. 

Tabel 5.3 Nilai parameter karakteristik DAS Gajahwong hasil kalibrasi dengan 

Visual Basic 

Parameter Satuan Hasil Kalibrasi 

Luas DAS km² 0.041 

Fraksi hutan - 0.024 

Fraksi larian permukaan - 70.000 

Kapasitas air tertekan (Soil Moisture Capacity 1) mm 168.787 

Initial Soil Moisture 1 mm 1.488 

Faktor tumbuhan - 149.830 

Kapasitas air bebas zona atas (Soil Moisture 

Capacity 2) 

mm 

46.694 

Initial Soil Moisture 2 mm 78.299 

Initial Ground Water Storage mm 0.100 

koefisien penyurutan tampungan air bebas zona 

atas 

- 

0.653 

koefisien penyurutan simpanan air tanah - 0.041 

Sumber : Hasil Penelitian 

Dan untuk evaluasi ketelitian model pada hasil kalibrasi dapat dilihat pada 

Tabel 5.4 berikut ini. 

Tabel 5.4 Evaluasi ketelitian model hasil kalibrasi dengan Visual Basic 

Ketelitian hasil 
Visual Basic 

DAS Papringan 

Kesalahan volume (VE)  

Koefisien korelasi (R)  

Koefisiensi Efisiensi (CE) 

3.2597% 

0.7736 

0.595 
Sumber : Hasil Penelitian 
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2. Hasil verifikasi parameter model RAINRUN 

Setelah diperoleh nilai-nilai parameter karakteristik DAS dari hasil kalibrasi 

model. Maka, untuk melakukan verifikasi model melalui penerapan aplikasi 

Visual Basic yang dibuat dalam penelitian ini untuk sta. Papringan, parameter 

karakteristik DAS Gajahwong, evaluasi ketelitian model pada hasil verifikasi 

dapat dilihat pada Tabel 5.5 berikut ini. 

Tabel 5.5 Evaluasi ketelitian model hasil verifikasi dengan Visual Basic 

Ketelitian hasil 
Visual Basic 

DAS Papringan 

Kesalahan volume (VE)  

Koefisien korelasi (R)  

Koefisiensi Efisiensi (CE) 

-21.1279% 

0.7921 

0.5579 

Sumber : Hasil Penelitian 

3. Hasil simulasi parameter model RAINRUN 

Selanjutnya adalah simulasi, dimana parameter karakteristik DAS yang sudah 

dilakukan kalibrasi sebelumnya akan digunakan kembali untuk perhitungan 

dengan menggunakan seluruh data curah hujan dan data evapotranspirasi yang ada 

(dari tahun 1994 sampai dengan 2004). Hasil dari simulasi parameter ini dapat 

dilihat dari nilai evaluasi ketelitian model pada Tabel 5.6 berikut ini. 

Tabel 5.6 Evaluasi ketelitian model hasil simulasi dengan Visual Basic 

Ketelitian hasil 
Visual Basic 

DAS Papringan 

Kesalahan volume (VE)  

Koefisien korelasi (R)  

Koefisiensi Efisiensi (CE) 

13.598% 

0.7758 

0.5773 

Sumber : Hasil Penelitian 

5.6 Evaluasi Hasil Percobaan 

Model RAINRUN merupakan pendekatan dari suatu proses yang 

sesungguhnya terjadi di alam, sehingga dalam proses simulasi selalu terdapat 

penyimpangan dan hal tersebut tidak dapat dihindari, namun penyimpangan 
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tersebut menjadi tidak wajar jika nilainya cukup besar dan tidak lagi dapat 

ditolerir. Upaya untuk mencapai hasil optimum yang merupakan tujuan dari 

optimasi dilakukan pada tahap kalibrasi. Kalibrasi merupakan proses penyesuaian 

parameter karakteristik DAS pada model yang berpengaruh pada kejadian di alam. 

Salah satu tolok ukur dari keberhasilan kalibrasi yaitu jika parameter yang di 

dapat diterapkan dalam proses verifikasi maka akan mempunyai hasil yang tidak 

jauh berbeda dengan hasil kalibrasi dalam hal koefisien korelasi (R), koefisien 

efisiensi (CE)  ataupun volume kesalahannya (VE). 

Evaluasi atas unjuk kerja program komputer Visual Basic dan solver excel 

dapat dilihat pada data hasil validasi program dilakukan dengan tinjauan pada 

koefisien korelasi, koefisien efisiensi dan kesalahan volume antara keduanya pada 

proses kalibrasi, verifikasi dan simulasi seperti ditampilkan pada Tabel 5.7 berikut 

ini. 

Tabel 5.7   Perbandingan unjuk kerja Pemodelan dengan Visual Basic dan  Solver 

Microsoft Excel 

Fungsi Tujuan 

DAS Gajahwong 

Solver 

Excel 

Visual 

Basic 

Koefisien Korelasi 

a. Kalibrasi. 

b. Verifikasi. 

c. Simulasi. 

 

0.772 

0.809 

0.778 

 

0.7736 

0.7921 

0.7758 

Kesalahan Volume 

a. Kalibrasi. 

b. Verifikasi. 

c. Simulasi 

 

3.391% 

-21.438% 

13.230% 

 

3.2597% 

-21.1279% 

13.598% 

Koefisien Effisiensi 

a. Kalibrasi. 

b. Verifikasi. 

c. Simulasi. 

 

0.592 

0.529 

0.566 

 

0.595 

0.5579 

0.5773 
Sumber : Wiwin Nanti (2007) dan Hasil Penelitian 

Secara umum dapat  dilihat baik pada proses kalibrasi, verifikasi maupun 

simulasi, Visual Basic menghasilkan nilai koefisien korelasi yang cenderung lebih 

rendah, namun pad nilai  koefisien efisiensi yang cenderung lebih besar dibanding 

dengan solver excel dengan metode GRG-Non Linear. Hal ini terjadi karena 
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dalam proses optimasi pada aplikasi yang dibuat di Visual Basic menggunakan 

solver excel juga, namun bedanya ada pada metode solving yang terdapat pada 

Microsoft Excel. Solving method yang dipilih penulis sebagai acuan dalam 

pengkoneksian data input dengan solver excel adalah dengan solving method 

“evolutionary”. Di dalam menu solver di Microsoft Excel, terdapat 3 pilihan 

metode solving, diantaranya GRG Non-Linear, Simplex LP dan evolutionary. 

Penulis memilih metode solving tersebut dikarenakan akan memungkinkan 

terpilihnya variasi lebih besar dari nilai solusi karena iterasi dilakukan berulang 

kali dengan nilai yang dicobakan juga berbeda-beda. Perbedaan perhitungan 

antara aplikasi yang dibuat menggunakan Visual Basic dan dengan menggunakan 

Microsoft Excel yang telah dianalisis adalah tidak terlalu jauh, meskipun 

perhitungan dengan excel lebih menghasilkan hasil yang lebih optimal. Berikut 

adalah grafik hasil analisis DAS Gajahwong yang dilakukan dengan Visual Basic 

dan dengan menggunakan Microsoft Excel. 

 

Gambar 5.25 Grafik hasil kalibrasi DAS Gajahwong dengan menggunakan 

aplikasi Visual Basic dan dengan menggunakan Microsoft Excel. 
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Gambar 5.26 Grafik hasil verifikasi DAS Gajahwong dengan menggunakan 

aplikasi Visual Basic dan dengan menggunakan Microsoft Excel. 

 

Gambar 5.27 Grafik hasil simulasi DAS Gajahwong dengan menggunakan 

aplikasi Visual Basic dan dengan menggunakan Microsoft Excel. 
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